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About this Manual

About this Manual

Welcome to the Acer n30 Handheld Manual. This Manual is designed to help you get
up and running quickly with your new Acer n30—a Windows® Powered Pocket PC
2003 handheld. It describes all you need to know about how to use your handheld as
well as the application programs that come with it.

This Manual will discuss the following topics:

e A tour of the Acer n30 system

¢ Setup and maintenance procedures

¢ Viewing and entering data

e Using the application programs bundled with you handheld

¢ Taking advantage of your handheld’s expansion features

¢ Synchronising data between your handheld and your computer

e Connecting your handheld to a computer, a network, or the Internet
¢ Personalising your handheld with your own preference settings

This Manual introduces you to the many ways your Acer n30 can help you organise
and manage both business and personal information to make your everyday activities
a more productive and satisfying experience.
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Your guides

First things first

We would like to thank you for making Acer n30 your choice for your handheld
needs. Your new sleek Acer n30 is a multi-functional tool packed with user-friendly
features and high-performance applications designed to make organising work-
related information and synchronising it with your personal activities a time-efficient
task. We hope you enjoy using your Acer n30 as much as we enjoyed creating it for
you.

Use your Acer n30 to effectively manage information related to both business and
personal tasks.

* Use the Microsoft® Pocket PC 2003 software to perform organising and
computing tasks

¢ Synchronise the information on your computer with the information on your
handheld using Microsoft® ActiveSync®

e Get connected to the Internet with the Microsoft® Pocket Internet Explorer

¢ Create an on-the-go backup file

e Expand your handheld’s capabilities using either the built-in SD/MMC slot

¢ Exchange information between devices that have Bluetooth capabilities.

e Beam information to another IR-enabled device

e Customise your handheld based on your personal requirements and
preferences

To help you use your Acer n30, we have designed a set of guides:

Programs on your handheld This Manual. Bundled in the Acer n30 Handheld
Companion CD, it provides online reference for using
your Acer n30.

The Acer n30 Handheld Help. To view Help,
tap {i and then Help.

Programs on your handheld The Acer n30 Handheld Companion CD.
Additional programs that can be
installed on your handheld

Connecting to and synchronising The Acer n30 Handheld Quick Guide.

with your computer
ActiveSync Help on your computer. To view Help, click
Help and then Microsoft ActiveSync Help.
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Last-minute updates and detailed The Read Me files. Located in the Microsoft ActiveSync
technical information folder on your computer and on the Acer n30
Handheld Companion CD.

Up-to-date information regarding http://www.acer.com/
your handheld

Package contents

Your Acer n30 comes packed in a cardboard box. Carefully unpack the box and
remove the contents. If any of the following items are missing or damaged, contact
your dealer immediately:

e Acer n30 handheld e Acer n30 Handheld Quick Guide
e Stylus e Acer n30 Handheld Companion
cD
¢ 3-in-one Sync Cable ( USB Host, ¢ End User License Agreement
USB Client, DC-in)
e AC Power Adapter ¢ International Travellers Warranty
e Slip Case

Maintaining your Acer n30

This section provides information on the following:

* Proper care and usage of your handheld
e Resetting your handheld

Proper care and usage of your Acer n30

Your Acer n30’s rugged and tough construction is designed to provide you with years
of reliable and trouble-free service. Observing the following general maintenance
procedures will help ensure this:

1 Take care not to scratch the screen of your handheld. Keep the screen clean. When
working with your handheld, use the supplied stylus or plastic-tipped pens intended
for use with touch-sensitive screens. Never use an actual pen or pencil or other sharp
object on the screen surface.

2 Your handheld is not waterproof and should not be exposed to rain or moisture.
Under extreme conditions, water may enter the circuitry through the front panel
buttons or expansion slots. In general, treat your handheld as you would a pocket
calculator or other small electronic device.

3 Take care not to drop your handheld or subject it to any strong impact. Do not place
your handheld in your back pocket; if you sit on it, you may damage it.
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First things first
Maintaining your Acer n30

Protect your handheld from temperature extremes. For example, do not leave your
handheld on the dashboard of a car on a hot day or on a day when temperatures are
below the freezing point. Also, keep it away from heaters and other sources of heat.

Do not use or store your handheld in any location that is extremely dusty, damp or
wet. Always use the (included) SD dummy card to protect the connectors when not in
use.

Use a soft, damp cloth to clean your handheld. If the surface of the screen becomes
soiled, clean it with a soft cloth moistened with diluted window-cleaning solution.

Resetting your Acer n30

You may have to perform a reset if your handheld no longer responds to the buttons
on the screen.

Performing a soft reset
A soft reset allows your handheld to get a fresh start, similar to rebooting a computer.
All records and entries are retained after a soft reset.

To perform a soft reset:

¢ Using the tip of your stylus, lightly press the reset button inside the hole on
the buttom of your handheld.

Performing a hard reset

A hard reset will erase all records and entries stored in your handheld. Never perform
a hard reset unless a soft reset does not correct your problem. When you perform your
next ActiveSync operation, you can restore any data that you previously synchronised
to your computer. To perform a hard reset:
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Use the tip of your stylus to toggle the reset switch to the left (a) and back to the right
(b) on the bottom of your handheld.

NOTE: When you perform a hard reset, formats, preferences, and other settings including
date and time are restored to their factory default settings. All data, records, and entries,
except for those stored in the ROM storage, will be erased.

Locking your Acer n30

Your handheld is not just a financial investment but a wealthy source of personal
information, some of which may be confidential so it is only logical to protect it from
any unauthorized access. The security setting of your handheld gives you the option
of assigning a lock password that will be required for access after a set period of
inactivity.

To assign a password

, Settings.

On the Personal tab, tap Password.
Select a password option.
¢ Simple 4 digit password
e Strong alphanumeric password
4 Define the period of inactivity before the password will be required for access.

5 Enter password then retype it to confirm.
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1 Getting started

This chapter will discuss the following topics:

e Basic requirements

¢ Feature highlights of your Acer n30

e Acer n30 system tour

e Step-by-step procedures on how to prepare your handheld for use
e Basic concepts in using your handheld

System requirements

In order to install the Microsoft® ActiveSync® software and use your new Acer n30
with a computer at work or at home, be sure the system(s) meet the following
minimum system and program requirements.

¢ Intel®Pentium processor (minimum 233 MHz)

e 64 MB RAM

* 120 MB disk space

e CD-ROM drive

e USB port or Infrared port

* SVGA (or compatible) graphics card supporting 256 colours

* Microsoft® Windows XP, 2000, ME or 98SE

¢ Microsoft® Internet Explorer 4.01

Features summary

Performance
e Samsung S3C2410 Application Processor 266 MHz
e System memory:
— 64 MB SDRAM for application storage
— 32 MB Flash ROM for operating system

e Microsoft® Windows Mobile™ 2003 Software for Pocket PC Premium Edition
with Outlook® 2002

Display
e 3.5" Transflective TFT LCD
e 240 x 320 resolution
® 65536 colour support
e Microsoft® ClearType technology for clearer, crisper font display
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Features summary

Audio
e Embedded AC '97 CODEC with CD-quality stereo output
e Built-in industry standard 2.5 mm earphone jack
¢ Built-in microphone

Proprietary 26-pin I/O connector

e USB Host (female)
e USB Client(male)
e DC power in

Connectivity

¢ SIR (Serial Infrared) capability
e Bluetooth 1.1

Expansion
¢ SD/MMC slot (SDIO compatible)
e USB Host1.1

Battery
e Rechargeable 1000 mAH Lithium iron battery
¢ 8 hours operation time for normal usage (when backlight is inactive)

NOTE: Length of battery operation will depend on power consumption which is based on
system resource use. For example, constantly using the backlight or using power-demanding
applications will shorten battery life between charges.

¢ 3 hour charging time from empty to full capacity

Design and ergonomics
e Stylish, light and thin design

Height 118 mm

Width 71 mm

Depth 13 mm

Weight 130 g (including stylus)

e User-friendly navigation features
— Scroll wheel for one-hand operation
— Quick buttons for easy launch of commonly-used applications

- Start [ button for one-tap access to all available applications
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Acer n30 tour

Front view

Pocket PC

1 Power LED indicator Power LED indicator.
- status description:

e Flashing green - Charging
e Steady green - Charging complete
® Flashing red - Alarm indicator, email receiving

2 Bluetooth LED indi- Bluetooth LED indicator. (for n30-B only)
cator - status description:

e Flashing blue - Bluetooth is on

3 LCD touchscreen Displays the applications and data stored in your handheld.
It is touch-sensitive and responds to the stylus or your
finger.

4 Quick button for Displays the Today screen. For more information on this

Today screen, refer to page 12.
5 Quick button for Activates the Calendar program. For more information on
Calendar this program, refer to page 29.
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6 Internal Speaker Outputs sounds from your handheld.
7 Quick button for Activates the Contacts program. For more information on
Contacts this program, refer to page 33.
8 Quick button for Activates the inbox program. For more information on this
Inbox program, refer to page 38.
NOTE:

If your handheld is turned off, pressing any Quick button turns on the handheld and opens
the program assigned to that button.

Left view

1 Power button Press to turn on your handheld on (power LED lights up
green) if it is off and returns to the last screen that was
displayed and off if it is on.

2 Scroll wheel Scroll up or down to display text and other information that
A extends beyond the area of the LCD touchscreen. Scroll
® through icons and pull down menus, press to open files/appli-
¥ cations (same as double tapping with the stylus).

3 IR port Uses infrared techbology to transmit and receive data from
other IR-enabled devices.

Using the backlight

If lighting conditions make it difficult for you to see the information on your
handheld, use the backlight to illuminate your screen.
To activate the backlight:

¢ Press the power button and hold it down for about two seconds. Release the
button when the backlight turns on.
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¢ To turn off the backlight, press the power button and hold it down for two
seconds. Release the button when the backlight turns off.

Top view

1 Earphone jack  Connects to audio line-out devices (earphones/headphones).

2 SD/MMC slot Accepts a Secure Digital or MultiMedia Card, allowing you to
add more memory, install add-on applications or use audio or
text files stored on it with internal applications. You can also use
expansion cards to back up data from your handheld.

3 Dummy SD- Use this to protect the SD connector when no card is installed.

card

4 Microphone Inputs audio into your handheld.

5 Stylus holder Secures the stylus to your handheld. To use the stylus, remove

from its holder and hold it as you would hold a pen or pencil.
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Bottom view

1 Soft reset A soft reset allows your handheld to get a fresh start, similar to
switch rebooting a computer. All records and entries are retained after
a soft reset.

2 Proprietary Connects your handheld to a portable or desktop computer and
26-pin I/0 DC power supply to an AC wall outlet to charge the battery.
connector - USB Host

- USB Client
- Serial
- DC power in

3 Hard reset Toggle to return you handheld settings to the factory defaults.

switch See “Performing a hard reset” on page vii.

Preparing to use your Acer n30

Perform the following easy installation tasks to begin using your handheld:

¢ Install the Microsoft® ActiveSync® software in your computer
e Connect the cable

e Charge your handheld

e Set up your handheld

e Perform the first ActiveSync operation
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(o) IO B ~ N V)

Installing the Microsoft® ActiveSync® software

The main function of the Microsoft® ActiveSync® software is to synchronise the
information on your computer with the information on your handheld.
Synchronisation compares the data on your handheld with your computer and
updates the information on both locations. This will then served as a backup data in
case something happens to your handheld.

The following instructions tells you how to install the ActiveSync® software.

Important installation notes

e Before installing ActiveSync, make sure that your handheld cradle is not yet
connected to your computer. Connect the cradle only after you have finished
installing ActiveSync.

¢ If you don't have Microsoft® Outlook® 98 or later installed, please install

Microsoft® Outlook® 2002 now. Even if you have Outlook 98 or Outlook 2000
installed, you are encouraged to upgrade to Outlook 2002.

¢ |tis recommended that users install Outlook 2002 from this CD before
installing ActiveSync.

¢ Do not copy the ActiveSync files to your computer’s hard disk. You must use
the Acer n30 Handheld Companion CD to place the files in their proper
locations and to decompress the files.

To install the Microsoft® ActiveSync® software

Exit any open programs, including those that run at startup, and disable any virus-
scanning software.

Insert the Acer n30 Handheld Companion CD into the computer’s CD-ROM drive.
The CD’s welcome page appears.
Click the animated forward icon to go to the next screen.
Click the Start Here tab on the right side of the screen.
Read the instructions and installation notes indicated on the Start Here screen.
Click the buttons on the left pane to install each of the individual applications.

e Outlook 2002 (recommended)

e ActiveSync® 3.7.1

After installation, the ActiveSync icon @' will appear on your computer’s system tray
(on the lower right-hand corner of the screen).

Refer to the ActiveSyncsoftware online Help for information on how to use the
software. If at any time, you would like to restart this setup program, simply re-insert
the CD into the CD-ROM drive.
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Connecting the computer

The 3-in-one sync cable that comes with your handheld enables you to synchronise the
information on your handheld with the data in your computer using ActiveSync
technology.

NOTE:
Don't plug the USB host into USB client.

To connect the computer

Plug the 3-in-one sync cable into the 26-pin I/O connector on the bottom of your
handheld and plug the USB client connector into an available USB port on your
computer.

Charging your Acer n30

For initial use, you need to charge your handheld for three hours. After that, you can
charge it for a few minutes each day to recharge the battery to full capacity. Normally,
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you can use your handheld for 8 straight hours of operation (backlight inactive)
before you need to recharge the battery.

To charge your Acer n30

Connect the AC adapter connector to the handheld, then plug the other end of the
AC adapter into any AC outlet.

Power LED status during charging:
e Charging - LED indicator flashes green
¢ Charging complete - LED indicator steady green

If the battery level becomes low in the course of normal use, a status icon appears on
the handheld screen indicating low or very low battery status. Perform an ActiveSync
operation to back up your data; then recharge the battery.

If your handheld shuts down (i.e., battery is competely drained out) you have about
72 hours (3 days) to recharge the battery before you lose all data on your handheld’s
internal memory.

Setting up your Acer n30

After you have initially charged your handheld for three hours, you can now set it up.
Refer to the instructions below.
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To set up your Acer n30

1 Turn on your handheld by pressing the power button on the left side.See "Left view"
on page 4, for the location of the power button.

2 Follow the onscreen instructions to set up your handheld.

Performing the first synchronisation process

After completing the setup procedures you can now perform the first ActiveSync
operation with the help of the 'New Partnership' setup wizard.

New Partnership ll

Set Up a Partnership

This wizard helps you establish a partnership between your
mobile device and this computer. You can set up either a
standard partnership to synchronize data between your
device and this computer, or a guest partnership to simply
transfer data between your device and this computer.

What kind of partnership would you like to establish between
your device and this computer?

% Standard partnership
| want to synchronize data between my device and
this computer, keeping data such as e-mail and
calendar items up-to-date in both places.

" Guest partnership
| want to only copy and move information between my
device and this computer, or add and remove
programs. | do not want to synchronize data.

¢ Back I Next > I Cancel Help

This wizard will help you:

10
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¢ Set up a partnership so you can synchronise information between your
handheld and your computer

e Customise your synchronisation settings

To perform the first synchronisation process
1 Connect the 3-in-one sync cable to your handheld.
2 Plug the USB client connector into a USB port on your computer.

The 'New Partnership' setup wizard will automatically start on your computer screen.

NOTE: If the wizard does not automatically appear, launch ActiveSync on your computer by
clicking on its icon from Start>Programs.

3 Follow the onscreen instructions.

The first synchronisation process will automatically begin when you finish using the
wizard.

After your first synchronisation, take a look at Calendar, Contacts, and Tasks on your
handheld. You'll notice that information you've stored in Microsoft Outlook on your
computer has been copied to your handheld, and you didn't have to type a word.
Disconnect your handheld from your computer and you're ready to go!

Once you have set up ActiveSync and completed the first synchronisation process, you
can initiate synchronisation from your handheld. To switch to ActiveSync on your
handheld, tap [, and then tap ActiveSync.

Command interface

Handheld buttons and the stylus

Your handheld has hardware buttons that control actions and scroll functions, and a
stylus for selecting items and entering information.

On your handheld, the stylus replaces the mouse.

11
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Command interface

Tap. Touch the screen once with the stylus to open items and select options.

e Drag. Hold the stylus on the screen and drag across the screen to select text
and images. Drag in a list to select multiple items.

¢ Tap and hold. Tap and hold the stylus on an item to see a list of actions

available for that item. On the pop-up menu that appears, tap the action you
want to perform.

Today screen

The center of the Today screen provides, at a glance, information that you need for
the day. Tap an item to view or edit details.

At the top to the screen are status icons. Tap an icon to view details or change options.

These icons appear at the top of every screen on your handheld device, not just the
Today screen.

When you turn on your handheld device for the first time each day, or after hours of
inactivity, the Today screen is displayed.

You can also display it by tapping

f3¥] and then Today.

Tapto switch

Tap to viesw connection status.
to & program .

Tapto change volume or mute all sounds.

B

Monday, March 24, 2003

Owner: Jack Smith —_Taptoopen anitem.
i 123) 555-5937
John's Bi aal

—Tapto change date and time.

Ll M@

—"our day at a glance

’— Your e-mail meszages

— “our active tasks

Tapto creste & new item .

12
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Start menu

From the Start menu, you can select programs, settings and Help topics. To display the
Start menu, from the top of any screen tap [JF].

Command bar

At the bottom of the screen is the command bar. You can use its menus and buttons to
perform tasks in programs. Depending upon which program you are using, the
buttons may vary from those depicted below.

e To create a new item in the current program, tap New.

* To see the name of a button, tap and hold the stylus on the button. Drag the
stylus off the button so that the command is not carried out.

New Edit Tools = B[~

[ I |
Tap to =elect menu  Tap to zelect button Tap to display the
commands. commands. input panel.

Pop-up menus

You can use pop-up menus to quickly select an action for an item.

£F &t

All Tasks Priority -

-

1 || Tap here to add a new task |

! Return D¥Ds
Call Stacey about Friday night
Get stamps at post office
Grocery shopping
Pick up food for dinner
Send out rent money

Oooodd

[l N ol ek Tap and hold to display
Create Copy the popup menu.
Delete Task ——— Tap outside the menu
— to close it without performing
ah action.
Beam Task...

Litt the stylus and tap
the action vou want.

MNew Tools & |4

13
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2 Entering data in your
Acer n30

You can enter data into your handheld in several ways:

¢ Use the input panel to enter typed text, either by using the soft keyboard or
other input method.

e Write directly on the screen.
e Draw pictures on the screen.
e Speak into your handheld’s microphone to record a message.

e Use Microsoft® ActiveSync® to synchronise or copy information from your
computer to your handheld.

Refer to page 63 for detailed information on using Microsoft® ActiveSync®.

Using the input panel

Use the input panel to enter information in any program on your handheld. You can
either type using the soft keyboard or write using Letter Recognizer, Block Recognizer,
or Transcriber. In either case, the characters appear as typed text on the screen.

NOTE: Transcriber is available only for the English and European Acer n30 models.

To show or hide the input panel
1 Tap the Input Panel button.

2 Tap the arrow next to the Input Panel button to see your choices.

Options...

Block Recognizer
* Keyboard

) Select an input method.
Letter Recognizer

Transcriber

Mew Edit Yiew Tools T,

Input Panel button.|

Tap to see your choices.

When you use the input panel, your handheld anticipates the word you are typing or
writing and displays it above the input panel. When you tap the displayed word, it is

15
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inserted into your text at the insertion point. The more you use your handheld, the
more words it learns to anticipate.

& g 427 D
Y

Monthly mee
reeirg E FBaon .
123[1[2[3[4]5]6]7 68[0[0]- =]
Tab[a[w[e r[t]y[u[i]o]p
caPlals|alf[aln]j[k[1[;]"
shift| z [x [c|¥|[b[n[m][,].][7] +
Ctijai] " [\ ] PNEEE
New Edit Tools [ # @j

To change word suggestion options

¢ To set word suggestion options such as the number of words suggested at
one time, tap , Settings, Personal tab, Input, and then the Word
Completion tab.

To type with the soft keyboard
1 Tap the arrow next to the Input Panel button, then Keyboard.
2 On the soft keyboard that is displayed, tap the keys with your stylus.

To use Letter Recognizer

With Letter Recognizer you can write letters using the stylus just as you would on
paper.

1 Tap the arrow next to the Input Panel button, then Letter Recognizer.

2 Write a letter in the box.
When you write a letter, it is converted to typed text that appears on the screen.

NOTE: For specific instructions on using Letter Recognizer, with Letter Recognizer open, tap
the question mark next to the writing area.
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Writing on the screen

To use Block Recognizer

With Block Recognizer you can input character strokes using the stylus that are similar
to those used on other devices.

1 Tap the arrow next to the Input Panel button, then Block Recognizer.
2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen.

NOTE: For specific instructions on using Block Recognizer, with Block Recognizer open, tap
the question mark next to the writing area.

To use Transcriber

With Transcriber you can write anywhere on the screen using the stylus just as you
would on paper.

NOTE: Transcriber is available only for the English and European Acer n30 models.

Unlike Letter Recognizer and Block Recognizer, you can write a sentence or more of
information. Then, pause and let Transcriber change the written characters to typed
characters.

1 Tap the arrow next to the Input Panel button and then Transcriber.

2 Write anywhere on the screen.

NOTE: For specific instructions on using Transcriber, with the Transcriber Input Panel open,
tap the question mark in the lower right hand corner of the screen.

To select and edit typed text

If you want to edit or format typed text, you must select it first.
1 Drag the stylus across the text to select it.
2 To cut, copy, and paste typed text:

a Tap and hold the selected words

b  Tapping an editing command on the pop-up menu, or tap a command on the Edit
menu.

Writing on the screen

In any program that accepts writing, such as the Notes program, and in the Notes tab
of Calendar, Contacts, and Tasks, you can use your stylus to write directly on the
screen. Write the way you do on paper. You can edit and format what you've written
and convert the information to text at a later time.
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Writing on the screen

To write on the screen

e Tap the Pen button to switch to writing mode. This action displays lines on
the screen to help you write.

Nutes o df 420 €3
F

T URN
TN
REPORT ' |

-
Mew Edit Tools E|“

Tap the Pen button and use
wour ztylus like 3 pen.

NOTE: Some programs that accept writing may not have the Pen button. See the
documentation for that program to find out how to switch to writing mode.

To select and edit written text

If you want to edit or format written text, you must select it first.

Tap and hold the stylus next to the text you want to select until the insertion point
appears.

Without lifting, drag the stylus across the text you want to select.
If you accidentally write on the screen, tap Tools, then Undo and try again.
_or-

You can also select text by tapping the Pen button to deselect it and then dragging
the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text:
a Tap and hold the selected words

b  Tapping an editing command on the pop-up menu, or tap a command on the Edit
menu.
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Writing on the screen

To convert writing to text

e Tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping
Recognize on the Tools menu (or tap and hold the selected words and then
tap Recognize on the pop-up menu). If a word is not recognized, it is left as
writing.

o 2429 €
.

Cut
Copy
Clear
Recognize | | | |
w -
New Edit Tools = |7 E|‘ New Edit Tools [ E] E|A
Seled the text wou wart
to convert and tap Recognize on the The witing is turned into
Pop-up menu. tent.

If the conversion is incorrect, you can select different words from a list of alternates or
return to the original writing. To do so:

1 Tap and hold the incorrect word (tap one word at a time).
2 On the pop-up menu, tap Alternates.

A menu with a list of alternate words appears.
3 Do either of the following:

a Tap the word you want to use.

b  Tap the writing at the top of the menu to return to the original writing.

NOTE:

Hyphenated words, foreign words that use special characters such as accents, and some
punctuation cannot be converted.

If you add writing to a word to change it (such as changing a "3" to an "8") after you
attempt to recognise the word, the writing you add will not be included if you attempt to
recognise the writing again.
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& ff 429 €D

T_:'.‘f n/

REFRRT!

report!

Report!

o[n|) [[——]|

MNew Edit Tools |E||é|

Tips for getting good recognition

e \Write neatly.

Tap to retum to your
original writing.

Or, tap the word you want
touse.

¢ \Write on the lines. Write the cross of the "t" and apostrophes below the top
line so that they are not confused with the word above. Write periods and

commas above the line.

e For better recognition, try increasing the zoom level to 300% using the Tools

menu.

¢ Write the letters of a word closely and leave big gaps between words so that
your handheld can easily tell where words begin and end.

Drawing on the screen

You can draw on the screen in the same way that you write on the screen. The
difference between writing and drawing on the screen is how you select items and
how they can be edited. For example, selected drawings can be resized, while writing

cannot.

To create a drawing

1 Cross three ruled lines on your first stroke.

A drawing box appears.
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Drawing on the screen

2 Subsequent strokes in or touching the drawing box become part of the drawing.

Drawings that do not cross three ruled lines will be treated as writing.

53 & ¢ 479 €
Y

X -

The drawing box indicates

O - the boundaries of the drawing.

MNew Edit Tools El‘

|F‘en buttan,

1]

TIP: You may want to change the zoom level so that you can more easily work on or view
your drawing. Tap Tools and then select a zoom level.

To select a drawing
If you want to edit or format a drawing, you must select it first.

¢ Tap and hold the stylus on the drawing until the selection handle appears.

¢ To select multiple drawings, deselect the Pen button and then drag to select
the drawings you want.

To edit a drawing

¢ To cut, copy, and paste selected drawings:
- Tap and hold the selected drawing.

— Tap an editing command on the pop-up menu, or tap a command on the
Edit menu.

e To resize a drawing:
— Make sure the Pen button is not selected.
— Drag a selection handle until required size is attained.
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Recording a message

In any program where you can write or draw on the screen, you can also quickly
capture thoughts, reminders, and phone numbers by recording a message.

¢ In Calendar, Tasks, and Contacts, you can include a recording in the Notes
tab.

¢ In Notes, you can either create a stand-alone recording or include a recording
in a written note. If you want to include the recording in a note, open the
note first.

¢ InInbox, you can add a recording to an email message.

To create a recording

Hold your handheld's microphone near your mouth or other source of sound.

NOTE: Refer to "Top view" on page 5 for the location of your handheld’s microphone.

Start recording by tapping the Record button on the Recording toolbar.
Make your recording.
To stop recording: Tap the Stop button on the Recording toolbar.

The new recording appears in the note list or as an embedded icon.

To play a recording

e Tapitin the list or tap its icon in the note.
5 & q2 429 €D

@ -l Indicste s an embedded

recarding.

Quote
from Adam

|
®[m]) [« |m]ut
Mew Edit Tools |é| E|‘

Tap to showor hide
the Recording toolbar.

Tap to begin recording.
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Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert preset or
frequently used messages into the text entry area.

To insert a My Text message
1 Tap My Text on the screen’s command bar.

2 Tap a message.

i . g
. 5 St
eﬂ MSN Messenger - "I 3:16 @

Hi. Can you meet ab 2:007

I have another appointrent scheduled For 2:00,
bt am availal

Yes.

MNo.

I can't talk right now.
I'll be right there.
I'm running late.

| ast messang
Where are you?

w3123 3
Tab[ g [w]e Coodbre 1
CAP[a]s ¥e.

Shirt| z | = Call me later.

[:t||.cf||'j| E | { Ilove my Pocket PO

Tools Chats |My TEHI:|_'1 E

D

Tapto select a
presntitten message.

NOTE: You can add text after inserting a My Text message before sending it.

To edit a My Text message
1 In the Tools menu, tap Edit and then tap My Text Messages.
2 Select the message you wish to edit and make desired changes.
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3 Managing applications
and information

This chapter will discuss the following topics:
e Opening and switching between applications in your handheld
¢ Using File Explorer to manage files
¢ Using the Find function to look for a specific file

Opening an application

You can open applications by doing either of the following:

e Tap b , Programs, and then the program name.
If you have many applications installed on your handheld, tap the scroll bar
to see all the available applications.

¢ Press any of the Quick buttons on the front panel of your handheld.
The icons on the buttons identify the programs.

Switching between applications

Choose from the following options to switch between applications:

¢ Select another program from the
e Press any of the Quick buttons on the front panel of your handheld.

NOTE: Some program names have been abbreviated in check boxes and drop-down menus.
To see the full spelling of an abbreviated label, tap and hold the stylus on the label. Drag the
stylus off the label so that the command is not carried out.

The following table contains a partial list of programs that are on available on your

handheld.
ActiveSync Synchronise information between your handheld and
@ computer.
Calendar Keep track of your appointments and create meeting
E requests.
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Contacts Keep track of your friends and colleagues.

Inbox Send and receive email messages.

Pocket Internet Browse Web and WAP sites, and download new

® D O

Explorer programs and files from the Internet.
. Notes Create handwritten or typed notes, drawings, and
recordings.
= Tasks Keep track of your tasks.
Pocket Excel Create new workbooks or view and edit Excel

workbooks created on your computer.

MSN Messenger  Send and receive instant messages with your MSN
Messenger contacts.

3

Pocket Word Create new documents or view and edit Word
documents created on your computer.

El
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Finding and organising information

Using the Find function and the File Explorer window will allow you to find and
manage your files easily.

To use Find

The Find function on your handheld helps you quickly locate information.

1 On the
2 Enter the text you want to find, then select a data type.

[27] menu, tap Find.

TIP: To quickly find information that is taking up storage space on your handheld, select
Larger than 64 KB in Type.

3 Tap Go to start the search.

Type text you Find: janet - E}
want to find. Tap here to
Type: Al data | Go start search.
Results
E|*
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Finding and organising information

To use File Explorer

Use File Explorer to locate files on your handheld and to organise these files into

folders.

e Onthe

Tap to change folders.

File Explorer

My Documents «

{} menu, tap Programs, and then File Explorer.

Seledt the =oit order
for the list.

o {2324 €9

Name

[C1Business

Tap the folder natme

=1 Personal
= Templates

¥iew All Files

Paste ]
Paste shortcut
MNew Folder

toopen it.

Tap and hold to create
a neswy folder .

Edit open |~ ]| M &

E|A

Quick. access bo
main memaory, network

—

files, and storage cards
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4 Managing Microsoft®
Pocket Outlook applications

This chapter will discuss the basic applications included in the Microsoft® Pocket
Outlook program installed in your handheld. This discussion will include:

¢ Calendar - schedule meetings and remind yourself of set appointments

¢ Contacts - keep at hand a directory of contact information

e Tasks - make a to-do list

* Notes - create textual or recorded notes of your thoughts and ideas

¢ Inbox - write, edit, and view your emails on the road

You can use these programs individually or together. For example, email addresses
stored in Contacts can be used to address e-mail messages in Inbox.

Calendar

Calendar enables you to conveniently manage your schedules and appointments or
any other activities associated with a time and date. You can schedule appointments,
including meetings and other events. Checking your appointments is easy using one
of several views—Agenda, Day, Week, Month, and Year.

NOTE: Switch view options by using the View menu.
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To open Calendar

Press the Calendar Quick button on the front panel of your handheld.
Calendar will open to today’s schedule.

Ealendar oF s 343 9
Mar 24, 03 EmT WTES Ej—'—ﬁﬁaptn 5o to tockay.

Conference call with Microsoft
1:30p-2:30p My office)
Meeting with Tom

——Tapto dizplay or edit
3:30p-5:00p (Bldg 31 Foom 432) the appointm ent details.

Mew Tuuls@%@ £|*

|Tap to creste a new appointment.

NOTE: You can customise the Calendar display, such as changing the first day of the week,
by tapping Options on the Tools menu.
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Scheduling an appointment

You can use Calendar to create or review appointments.

To create an appointment

If you are in Day or Week view, tap the desired date and time for the appointment.
Tap New.

Using the input panel, enter a description and a location.

Tap first to select the field.

If needed, tap the date and time to change them.

Enter other desired information.

You will need to hide the input panel to see all available fields.

To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see "Notes" later in this chapter.

After entering the desired information, tap OK.

TIP: If you select Remind me in an appointment, your handheld will remind you according
to the options set in i:j , Settings, Personal tab, Sounds & Reminders.

Using the Calendar summary screen

When you tap an appointment in Calendar, a summary screen is displayed. To change
the appointment, tap Edit.

#i¥|calendar & o 343 9
Lunch w/ Adam i
12:00p-1:00p Sun, 862000 —T—View appointment details.
Corner Cafe
Femember partfolio, — 1 ew
Edit Tools E|A
1

Tap to change
appointment .
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Creating a meeting request

You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The
meeting request will be created automatically and sent either when you synchronise
Inbox or when you connect to your email server. Indicate how you want meeting
requests sent by tapping Tools and then Options. If you send and receive email
messages through ActiveSync, select ActiveSync.

To schedule a meeting
1 Create an appointment.
In the appointment details, hide the input panel, and then tap Attendees.

From the list of email addresses you've entered in Contacts, select the meeting
attendees.

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see the Help menu
of Calendar and Inbox in your handheld.
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Contacts

Contacts maintains a list of your friends’ and colleagues’ contact information. Using
your handheld’s infrared (IR) port or Bluetooth, you can quickly share some or all of
this information with other device users.

To open Contacts

¢ Press the Contacts Quick button on the front panel of your handheld.
Contacts will open to the Contacts list.

NOTE: To change the way information is displayed in the list, tap Tools and then Options.

Creating a contact

Tap New.
Tap to retum to the contact
ligt ithe cortact iz saved
aLtarm stically).
.5}1 Contacts Pl F L] @
Mame: il
Job title: H
Department: :
Compary:
Work tel:
Work Fax:
Work addr: h
E-mail: |
Mahile tel: »1— Scrol to see more fields.
Dietails | Mokes | Maotes iz a good place
123|1 |2 |3 |4 |5 |E |? |B |g |l]|- =|* for maps and directions.
Tab[q[wle|r[t[y[u]io[p
caPlas[d[fa[h[j[k[I[;]"]
shiftf z[x[c[v[b[n[m][, [. [/«
ctfaii]* [\ ] [L]t]e]=
Edit =

Using the input panel, enter a name and other contact information.
You will need to scroll down to see all available fields.

To assign the contact to a category, scroll to and tap Categories and select a category
from the list.

In the contact list, you can display contacts by category.

To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see "Notes," later in this chapter.
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5 After entering the desired information, tap OK to return to the Contact list.

Finding a contact
There are four ways to find a contact:

¢ In the Contact list, enter a contact name in the box under the navigation bar.
To show all contacts again, clear text from the box or tap the button to the
right of the box.

¢ In the Contact list, tap the category list (labeled All Contacts by default) and
select the type of contact that you want displayed.

To show all contacts again, select All Contacts.
To view a contact not assigned to a category, select None.

¢ To view the names of companies your contacts work for, in the contact list,
tap View > By Company.
The number of contacts that work for that company will be displayed to the
right of the company name.

e Tap b , Find, enter the contact name, select Contacts for the type, and then
tap Go.

Using the Contacts summary screen

When you tap a contact in the Contact list, a summary screen is displayed. To change
the contact information, tap Edit.

.EF Calendar & oz 343 6
Lunch w/ Adam iy
12:00p-1:00p Sun, 862000 —1—Viewappaointment details.
Carner Cafie
Femember portfolia, — e
Edit Tools E|A
1

Tap to change
appointment .
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Tasks

Use Tasks to keep track of what you have to do and prioritise them based on their
importance and urgency.

To open Tasks

o Tap 2] then, Tasks.
Tasks will open to the Tasks list.

NOTE: To change the way information is displayed in the list, tap Tools and then Options.

Creating a task
Tap New.
Using the input panel, enter a description.

You can enter a start date and due date or enter other information by first tapping
the field.

If the input panel is open, you will need to hide it to see all available fields.

To assign the task to a category, tap Categories and select a category from the list.
In the task list, you can display tasks by category.

To add notes, tap the Notes tab.

You can enter text, draw, or create a recording. For more information on creating
notes, see "Notes" later in this chapter.
Tap to return to the task

ligt ithe task is saved
autorm atically.

& o2 a3 (D

Subject: || w—Tap to choose from
Prioriby:  ™OF ral predefined subjects.
Status: Mot Completed
Starts: Mone
Cue; Mone
Occurs: DNCE

Feminder:

Categories: MO categories...
Task | [okes [ Motes iz & good place
123|1|2|3|4|5|E|?|B|9|D|- =|¢ for maps and drawings.

Tabjq |wle|r|t|y|u|i|o|p|[[]|]
caPla[s[d[f[a[n]ifk[1];]"]
shift| z [x [c[v[b[n[m[,[.[/[+
ctlaia] - [\ ] [L]1]e]>

Edit = |~

35



4 Managing Microsoft® Pocket Outlook applications
Tasks

6 After entering the desired information, tap OK to return to the task list.

TIP: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap
Tap Here to add a new task and enter your task information.

Using the summary screen

When you tap a task in the task list, a summary screen is displayed. To change the task,
tap Edit.

&5 & e @
ﬂ. ___ Areminder has been set
For this kask

—iewtazk details.

Call Stacey

Starts: 43,2003

Cue: 4f3f2003 _ "
& —Tap to showwand hide additionsl

summaty information.

Be pleasant--her cat recently gok sick,

Yiewy notes.

Edit Tools E|A

|—T ap to change task.
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Notes

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with
Notes. You can create a written note or a recording. You can also include a recording
in a note. If a note is open when you create the recording, it will be included in the
note as an icon. If the note list is displayed, it will be created as a stand-alone
recording.

To open Notes

o Tap [ then, Notes.
Notes will open to the Notes list.

o {Z 429 €3

(%) All Folders ~ Name +—Tap to change the sort
arder ofthe list.
l._|Business1 8:54 a 424b

Dutluuk Motes1
! Personall

Tap to open a note or

Create Copy play a recording.

Delete

Tap and hold to display
Select all a pop-up menu of actions,

Send via E-mail...
Beam File...

Rename;/Move...

Tap to record.

|
®|m|) [J=——— |t
NEWTDD'S@ EI*

|Tapt|:| create a new item.

Tap to show ar hide the
R ecording toalbar.

Creating a note
1 Tap New.
2 Create a note by writing, drawing, typing, or recording.

NOTE: For more information about using the input panel, writing and drawing on the
screen, and creating recordings, see "2 Entering data in your Acer n30" on page 15.
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Inbox

Use Inbox to send and receive e-mail messages by doing either of the following:

¢ Synchronise e-mail messages with Microsoft Exchange or Microsoft Outlook
on your computer.

¢ Send and receive e-mail messages by connecting directly to an e-mail server
through an Internet service provider (ISP) or a network.

Opening the Inbox

* Press the Inbox Quick button on the front panel of your handheld.
Inbox will open to the Inbox’ folder navigator.

Synchronising email messages

Email messages can be synchronised as part of the general synchronisation process.
You will need to enable Inbox synchronisation in ActiveSync.

For information on enabling Inbox synchronisation, see ActiveSync Help on your
computer.

During synchronisation:

e Messages are copied from the mail folders of Exchange or Outlook on your
computer to the ActiveSync folder in Inbox on your handheld. By default, you
will receive messages from the past three days only, the first 100 lines of each
message, and file attachments of less than 100 KB in size.

¢ Email messages in the Outbox folder on your handheld are transferred to
Exchange or Outlook, and then sent from those programs.

¢ Email messages in subfolders must be selected in ActiveSync on your
computer in order to be transferred.

TIP: You can also synchronise email messages with your computer from a remote location.
For more information, see the ActiveSync Help menu in your computer.

Connecting directly to an email server

In addition to synchronising email messages with your computer, you can send and
receive email messages by connecting to an email server using a modem or a network
card connected to your handheld. You'll need to set up a remote connection to a
network or an ISP, and a connection to your email server. For more information, refer
to "9 Getting connected" on page 65.

When you connect to the email server, new messages are downloaded to your
handheld’s Inbox folder, messages in the handheld’s Outbox folder are sent, and
messages that have been deleted on the email server are removed from the
handheld’s Inbox folder.

Messages that you receive directly from an email server are linked to your email server
rather than your computer. When you delete a message on your handheld, it is also
deleted from the email server the next time you connect based on the settings you
selected in ActiveSync.
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You can work online or offline. When working online, you read and respond to
messages while connected to the email server. Messages are sent as soon as you tap
Send, which saves space on your handheld.

When working offline, once you've downloaded new message headers or partial
messages, you can disconnect from the email server and then decide which messages
to download completely. The next time you connect, Inbox downloads the complete
messages you've marked for retrieval and sends the messages you've composed.

Using the Message list

Messages you receive are displayed in the message list. By default, the most recently
received messages are displayed first in the list.

When you receive a message, tap it to open it. Unread messages are displayed in bold.

When you connect to your email server or synchronise with your computer, by default,
you'll receive messages from the last five days only, the first 100 lines of each new
message, and file attachments of less than 100 KB in size. The original messages
remain on the email server or your computer.

You can mark the messages that you want to retrieve in full during your next
synchronisation or email server connection. Follow the steps below.

In the message list, tap and hold the message you want to retrieve.

On the pop-up menu, tap Mark for Download. The icons in the Inbox message list give
you visual indications of message status.

Specify your downloading preferences when you set up the service or select your
synchronisation options. You can change them at any time:

e Change options for Inbox synchronisation using ActiveSync options. For more
information, see ActiveSync Help.

¢ To change options for direct email server connections in Inbox on your
handheld.

a Tap Tools and then tap Options.
b  On the Service tab, tap the service you want to change.

¢ Tap and hold the service and select Delete to remove a service.

Composing a message
Tap New.

In the To field, enter an email address of one or more recipients, separating them with
a semicolon, or select a name from the contact list by tapping the Address Book
button.

All e-mail addresses entered in the e-mail fields in Contacts appear in the Address
Book.

Compose your message.
To enter preset or frequently used messages, tap My Text and select a message.
Tap Send when you've finished the message.

If you are working offline, the message is moved to the Outbox folder and will be sent
the next time you connect.
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Managing email messages and folders

By default, messages are displayed in one of five folders for each service you have
created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items.

¢ The behavior of the Deleted and Sent Items folders depends on the options
you have chosen. To set these options, in the message list:

a Tap Tools and then Options.
b  On the Message tab, select your options.

¢ If you want to organise messages into additional folders tap Tools, and then
Manage Folders to create new folders.

¢ To move a message to another folder, in the message list, tap and hold the
message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an email server

The behavior of the folders you create depends on whether you are using ActiveSync,
POP3, or IMAPA4.

¢ If you use ActiveSync, email messages in the Inbox folder in Outlook will
automatically be synchronised with your handheld. You can select to
synchronise additional folders by designating them for ActiveSync. The
folders you create and the messages you move will then be mirrored on the
server. For example, if you move two messages from the Inbox folder to a
folder named Family, and you have designated Family for synchronisation,
the server creates a copy of the Family folder and copies the messages into
that folder. You can then read the messages while away from your computer.

¢ If you use POP3 and you move email messages to a folder you created, the
link is broken between the messages on your handheld and their copies on
the email server. The next time you connect, the email server will see that the
messages are missing from the handheld’s Inbox and delete them from the
server. This prevents you from having duplicate copies of a message, but it
also means that you will no longer have access to messages that you move to
folders created from anywhere except your handheld.

¢ If you use IMAP4, the folders you create and the email messages you move
are mirrored on the server. Therefore, messages are available to you anytime
you connect to your email server, whether it is from your handheld or from
your computer. This synchronisation of folders occurs whenever you connect
to your mail server, create new folders, or rename/delete folders when
connected.
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Pocket Word

Pocket Word

5 Managing Microsoft® Pocket
PC 2003 companion programs

Perform your usual computing tasks on-the-road using the Microsoft® Pocket PC 2003
companion programs which includes:

e Pocket Word
e Pocket Excel

e MSN® Messenger
e Microsoft® Windows Media™ Player for Pocket PC
e Microsoft® Reader for Pocket PC

NOTE: Microsoft® Reader is available only for the English and European Acer n30 models.

To open a companion program on your handheld, tap Programs on the
and then tap the program name.

Pocket Word works with Microsoft Word on your computer to give you easy access to
copies of your documents. You can:
¢ Create new documents on your handheld, such as letters, meeting minutes,

and trip reports, or you can copy documents from your computer to your
handheld.

¢ Synchronise documents between your computer and your handheld so that
you have the most up-to-date content in both locations.

To create a new file

o Tap [, Programs, Pocket Word, and then New.
A blank document appears. Or, if you've selected a template for new
documents in the Options dialog box, that template appears with
appropriate text and formatting already provided.

You can open only one document at a time; when you open a second document, you'll
be asked to save the first. You can save a document you create or edit in a variety of
formats, including:

e Word (.doc)

e Pocket Word (.psw)

® Rich Text Format (.rtf)

* Plain Text (.txt)
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NOTE: When you choose to create a new document, you will be prompted to save any
already open document.

To use the Pocket Word file list
Pocket Word contains a list of the files stored on your handheld.

e Tap a file in the list to open it.

¢ To delete, make copies of, and send files, tap and hold a file in the list. Then,
select the appropriate action on the pop-up menu.

Zelect the type of folder you
want dizplayed inthe list.

Pocket Word oF o2 1:34 9
E} All Folders ~ Name »| 1.1, chanhge the sort
Awards 11/4/99 290 arder ofthe list.

&) Cornell Academic ... 10/4/00 35k
® |Expert Opinions 12/4,/01 22k
& ismcover2002 a9/14,/02

icmeacunaa 2Nt 2,-"‘23,-"‘“3

Tap to apen a document.

te C
”'E b 10/3/01 20k
oelete 10/8/02  bilk
Select All

Tap ahd hold an tem to zee

2end via E-mail... ]
a pop-up mend of actions .

Beam File...

Rename;Move...

Mew Tools E|*

|Tap to creste & nevw document.

To enter information

You can enter information in Pocket Word in one of four modes—typing, writing,
drawing, and recording, which are displayed on the View menu. Each mode has its
own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button
on the command bar.

If you're opening a Word document created on a computer, select Wrap to Window
on the View menu so that you can see the entire document.

TIP: You can change the zoom magnification by tapping View and then Zoom. Then select
the percentage you want. Select a higher percentage to enter text and a lower one to see
more of your document.
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Typing mode
e Using the input panel, enter typed text into the document.
For more information on entering typed text, see "Using the input panel" on
page 15.

e To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the mouse to
drag through the text you want to select.

* You can search a document to find text by tapping Edit and then Find/
Replace.

Writing mode

In writing mode, use your stylus to write directly on the screen. Ruled lines are
displayed as a guide, and the zoom magnification is greater than in typing mode to
allow you to write more easily.

For more information on writing and selecting writing, see "Writing on the screen"
on page 17.

£iZ Pocket Word o

With Space hutton seleded,
drag to insert space. An arrow
appears showing the space
direction and size .

‘2 §|A J& | 2 ———Tap to highlight seleded test.

NEw Edit View Tuu+ 8

Tapto s=led formatting options,
Aich az peh weight ahd line colar,

Space button.
Fen utton,

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing,
and can be edited and manipulated as described in the following section.

NOTE: Written words are converted to graphics (metafiles) when a Pocket Word document
is converted to a Word document on your computer.
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Pocket Excel

Drawing mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide.
When you lift your stylus off the screen after the first stroke, you'll see a drawing box
indicating the boundaries of the drawing. Every subsequent stroke within or touching
the drawing box becomes part of the drawing.

For more information on drawing and selecting drawings, see "Drawing on the
screen" on page 20.

Select Shape on the
pop-up menu to convert
ohjects to proper shapes .

£2' Pocket Word ot o 4144 @

000

Reszize an ohject by dragging
the zelection handles.

O00
Room sex uP

[Z]E |+ L]~ & o 2

MNew Edil] Yiew Tnuls E|*
Tap an arow to Tap to zelect formatting options |
zee your chaices. zuch az line weight, fill color, and line color,
Pen button.

Recording mode

In recording mode, embed a recording into your document. Recordings are saved as
.wav files.

For more information on recording, see "Recording a message" on page 22.
> Programs > Pocket Word then,

For more information on using Pocket Word, tap [}
tap Help from the [ menu.

Pocket Excel works with Microsoft Excel on your computer to give you easy access to
copies of your workbooks. You can:
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¢ Create new workbooks on your handheld, such as expense reports and
mileage logs, or you can copy workbooks from your computer to your
handheld.

¢ Synchronise workbooks between your computer and your handheld so that
you have the most up-to-date content in both locations.

Creating a new workbook

» Tap [}, Programs, Pocket Excel, and then New.

A blank workbook appears. Or, if you've selected a template for new
workbooks in the Options dialog box, that template appears with
appropriate text and formatting already provided.

You can open only one workbook at a time; when you open a second workbook,
you'll be asked to save the first. You can save a workbook you create or edit in a
variety of formats, including:

e Pocket Excel (.pxl)

e Excel (.xls).

NOTE: When you choose to create a new document, you will be prompted to save any
already open document.

To create a Pocket Excel file list
Pocket Excel contains a list of the files stored on your handheld.

¢ Tap a file in the list to open it.

¢ To delete, make copies of, and send files, tap and hold a file in the list. Then
select the appropriate action from the pop-up menu.

Displaying the toolbar

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions,
sorting, and filtering, in its toolbar.
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e Tap View and then Toolbar.
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Protecting your workbooks
If your workbook contains sensitive information, you can protect it with a password.

¢ Open the workbook, tap Edit, and then Password.

Every time you open the workbook, you will need to enter the password, so
choose one that is easy for you to remember but hard for others to guess.

Tips for working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:
¢ View in full-screen mode to see as much of your worksheet as possible.
— Tap View and then Full Screen.
— To exit full-screen mode, tap Restore.
e Show and hide window elements.
— Tap View and then tap the elements you want to show or hide.

* You might want to freeze the top and left most panes in a worksheet to keep
row and column labels visible as you scroll through a sheet.

a Select the cell where you want to freeze panes.
b  Tap View and then Freeze Panes.
¢ Split panes to view different areas of a large worksheet.
a Tap View and then Split.
b  Then drag the split bar to where you want it.
To remove the split, tap View and then Remove Split.

¢ Show and hide rows and columns.
— To hide a hidden row or column:
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a Select a cell in the row or column you want to hide.
b  Tap Format, then Row or Column, and then Hide.

— To show a hidden row or column:

a Tap Tools, then Go To, and then type a reference that is in the hidden
row or column.

b  Then tap Format, then Row or Column, and then Unhide.

For more information on using Pocket Excel, tap f#¥] > Programs > Pocket Excel then,
tap Help from the & menu.

MSN® Messenger

MSN® Messenger on your handheld is an instant messaging program that lets you:
e See who is online
¢ Send and receive instant messages
¢ Have instant message conversations with groups of contacts

Requirements to use MSN Messenger
* Microsoft Passport™ account or a Microsoft Exchange email account.

e Passport to use MSN Messenger Service. If you have a Hotmail® or MSN
account, you already have a Passport.

Once you have obtained either a Microsoft Passport or a Microsoft Exchange account,
you are ready to set up your account.

TIP: Sign up for a Microsoft Passport account at (http://www.passport.com/). Get a free
Microsoft Hotmail email address at (http:/www.hotmail.com/).

Setting up

Before you can connect, you must enter Passport or Exchange account information.

To set up an account and sign in:

1 In the Tools menu, tap Options.
In the Accounts tab, enter your Passport or Exchange account information.
To sign in, tap the sign-in screen and enter your email address and password.

NOTE: If you already use MSN Messenger on your computer, your contacts will show up on
your handheld without being added again.

Working with contacts

The MSN Messenger window shows all of your messenger contacts at a glance, divided
into Online and Not Online categories. From this view, while connected, you can chat,
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MSN® Messenger

l.ﬂ;«'" MSN Messenger o o 44 9
_'i Kim Akers (Online)
_'i Online

_'i Adarn Barr

_'i Ja

Ei. Fandall {asway)
‘1 Mot Online
‘1 RFichard Bready
‘1 David Hodgson
@ SR

send a email, block the contact from chatting with you, or delete contacts from your
list using the pop-up menu.

————Tap a contact to sgant & chat.

Send Mail (Tim@woodgrovebank.c...
Block
Delete Contact

Properties

———Tap and hold to display

a pop-up menu of actions.

Tools E|A

Chatting with contacts

Tap a contact name to open a chat window.

To see others online without being seen, in the Tools menu, tap My Status
and select Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked
contact's list.

To unblock a contact, tap and hold the contact, then tap Unblock on the pop-
up menu.

Enter your message in the text entry area at the bottom of the screen, or tap My Text
to enter a preset message.

48



5 Managing Microsoft® Pocket PC 2003 companion programs
Microsoft® Windows Media™ Player for Pocket PC
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Tips when chatting with contacts
¢ To invite another contact to a multi-user chat, in the Tools menu, tap Invite
and tap the contact you want to invite.

o 'tl;o switch back to the main window without closing a chat, tap the Contacts
utton.

e To revert back to your chat window, tap Chats and select the person whom
you were chatting with.

¢ To know if the contact you are chatting with is responding, look for the
message under the text entry area.

For more information on using MSN Messenger, tap fat
then, tap Help from the [ menu.

| > Programs > MSN Messenger

Microsoft® Windows Media™ Player for Pocket PC

Use Microsoft® Windows Media™ Player for Pocket PC to play digital audio and video
files (Windows Media and MP3 files) that are:
¢ Stored on your handheld

¢ Copied from Microsoft Windows Media Player on your computer to your
handheld

e On a network

For more information about using Windows Media Player for Pocket PC, tap [
then tap Help.

,and
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Microsoft® Reader for Pocket PC

Use Microsoft® Reader for Pocket PC to read eBooks on your handheld.

You can also download books from your favorite eBook Web site to your computer.
Then, use ActiveSync to copy the book files to your handheld. The books appear in the
Reader Library, where you can tap them in the list to open them.

NOTE: Microsoft® Reader is available only for the English and European Acer n30 models.

Using the Guidebook

The Guidebook contains all the information you'll need to use the Microsoft Reader.

To open the Guidebook:
¢ Tap Help on the Reader command bar.
_Or_

e On a book page, tap and hold on the book title, and then tap Help on the
pop-up menu.

Getting books on your Acer n30

You can download book files from the Web. Just visit your favorite eBook retailer and
follow the instructions to download the book files.

Sample books and a dictionary are also included in the MSReader folder in the Extras
folder on the Acer n30 Handheld Companion CD.

Use ActiveSync to download the files from your computer to your handheld as
described in the Read Me file in the MSReader folder.

Using the Library

The Library is your Reader home page; it displays a list of all books stored on your
handheld or storage device.

To open the Library:

® On the Reader command bar, tap Library.
_or_

¢ On a book page, tap the book title, and then tap Library on the pop-up
menu.

Opening a book

e Tap a book title in the Library list.
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Microsoft® Reader for Pocket PC
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Reading a book
Each book consists of a cover page, an optional table of contents, and the pages of
the book. You can:

¢ Annotate the book with highlighting, bookmarks, notes, and drawings.

e Search for text and look up definitions for words.
In addition to the text, each book page includes a page number and book title.
Navigation options are listed in the bottom portion of the cover page. Page through
the book by:

e Using the Scroll wheel on your handheld

e Tapping the page number on each page
The first time you open a book, you'll probably want to go to the first page or to the
table of contents, if there is one. Subsequently, whenever you open the book, you'll
be automatically taken to the last page read.
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Using Reader features

Reading a book electronically gives you several options not available with paper
books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the pop-
up menu, as described in the following sections.

Search for text

Tap Find on the pop-up menu.

Enter the word you want to search for.
Tap the desired Find option.

Reader highlights found text on the page.

¢ To close Find, tap outside the box.
e To return to your original page, tap the title and then tap Return on the pop-

up menu.
Copy text

You can copy text from books that support this feature into any program that accepts
text.

On a book page, select the text you want to copy.
Tap Copy Text on the pop-up menu.

The text can be pasted into the program of your choice.
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Book annotations

To see a list of a book's annotations, including bookmarks, highlights, text notes, and
drawings:

1 Tap Annotations Index on the book's cover page.

2 Tap an entry in the list to go to the annotated page.

To use bookmarks

¢ When you add a bookmark to a book, a color-coded bookmark icon appears
in the right margin. From anywhere in the book, tap the bookmark icon to go
to the bookmarked page.

NOTE: You can add multiple bookmarks to a book.

To use highlights
e When you highlight text, it appears with a colored background.

To use notes

e When you attach a note to text, you enter the text in a note pad that appears
on top of the book page. A Note icon will display in the left margin. To show
or hide the note, tap the icon.

To add drawings

¢ When you add a drawing, a Drawing icon appears in the bottom-left corner
of the page, and drawing tools appear across the bottom of the page. Draw
by dragging your stylus.

Removing a book

When you finish reading a book, you can delete it to conserve space on your
handheld. If a copy of the book is stored on your computer, you can download it again
at any time.

1 Tap and hold the title in the Library list.

2 Tap Delete on the pop-up menu.
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© Backup and restore
data

Backup/Restore enables you to back up data files and applications from your
handheld to a storage device and to restore data to your handheld. Advanced security
features offer password protection of sensitive documents/applications during Backup
and/or Restore operations. The expansion features of your handheld allow you to use
any of the following storage devices:

e SD Card (Secure Digita Card)
e MMC card (MultiMedia Card)
e USB thumb drive

¢ ROM storage(ROM storage is for PIM data backup and restore operations
only)

During a backup or restore operation, the power button serves as a pause/resume
button to control the pace of the operation.

There are three tabs (from left to right) in the program window corresponding to the
three functions of Backup and Restore.

e Backup
e AutoBackup
e Restore

To launch Backup/Restore:

Insert a storage device (SD/MMC card or USB thumb drive) if you want to do backup/
restore operation on a storage device.

For instructions on how to insert storage devices, please refer to "7 Using expansion
features" on page 61.

Tap 4], Programs, and then Backup/Restore.
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Backup function

,_;_C} Backup/Restore ¥ £ 12:37 @

Backup
File narne: !
Backup to: ROM Storage -
512KE Free
Option:  [PIM Only 47.14KB  ~]

Backup | AutoBackup | Restore |
About E|*

To perform data backup
1 Close all running programs except for Backup/Restore.

2 In the Backup tab, choose whether to accept the default filename (MyBackup) or type
a new one by tapping on the keyboard icon on the bottom of the screen.

3 Select a storage device from the 'Backup to' pull-down menu.
4 Define the backup scope (default: PIM only) from ‘Option' pull-down menu.

NOTE: ROM storage is a valid backup destination only if PIM Only is defined as
backup scope.

Check the password box and enter a password if you want to secure the backup file.
Tap Start to proceed with the backup process.
During the backup process, a progress screen will appear displaying backup status.

7 When the backup process is completed, a message box appears, saying that backup
operation is completed.

56



6 Backup and restore data

AutoBackup function

With AutoBackup, you can set your handheld to perform an automatic data backup
when battery power is lower than 30%. For configuring in AutoBackup screen, please
refer to the instructions described in "Backup function". .

.J_i:j' Backup/Restore ¢F £ 12:32 @

AutoBackup

Do automatic backup when battery
powwer is lower than 30%.,

Filz narme: My sutoBackup
Backup to: RioM Storage -

S912KE Free
4] Password
Option;  [PIM Only 47148 7]

Backup | AutoBackup | Restore |

About E|A

When AutoBackup is activated and the specified storage device is not attached to
your handheld when 30% of battery level is reached, then no backup procedure will
be performed.

NOTE: 'MyAutoBackup'is the default file name of the backup file generated by the
AutoBackup operation.

Restore function

You can only restore backup files that are generated by Backup/Restore; file format is
*.abk (Acer backup).

To perform data restoration

Close all running programs except for Backup/Restore.
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Select a source storage device from the 'Restore from' pulldown menu.

The lower half of the screen will display a list of files contained in the selected storage
device. Filename, file size and date when the backup file was created are indicated in
the list.

ﬁr Backup/Restore 4f = 12:17 @

Restore
Restore From: SDfmMC -
Qption:

File: narne | Size | Date

5 PIM_Backup  S0U9SKE 0707
i Al _Backup 4.58MB  09/07

Backup | AutoBackup | Restare |
About E|A

Tap a filename to select the file you wish to restore, and please note that non-.abk
files are not shown.

Select file, then tap "start" button. The window will shift to display the backup file
information including:

¢ File name - filename of the selected .abk file.
¢ Backup date - date when the selected .abk file was created.
¢ Backup option & file size.

e Main memory free size - free space in your handheld’s main storage memory.
This should be bigger than the file size of the selected .abk file for the restore
process to continue.

Tap Start again to proceed with the restore process.
During the restore process, a progress screen will appear displaying restore status.

When the restore process is completed, a message box appears, saying restore
operation is complete.

To delete a file from a storage device

To increase the size of available free space in a storage device, you can delete files that
you no longer need.

Tap the Restore tab.
Tap a menu item to select a storage device.

From the list, tap a filename until a delete pop-up menu is displayed.
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4 Tap Delete to remove the file.

Backup/Restore 4 (£ 12:19 @
Restore
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Using an SDIMMC card

/ Using expansion
features

The slim and lightweight design of your Acer n30 belies its impressive expansion
features . These expansion features include:

¢ Integrated dual use SD/MMC slot

e USB host port via 3-in-one sync cable
These expansion features allow you to:

¢ Install additional applications

¢ Increase storage capacity

¢ Perform backup procedures

NOTE: When using any peripheral device with your handheld, please refer to the
documentation accompanying each device for information on how to install and operate it.

Using an SD/MMC card

On the top side of your handheld is an SD/MMC slot. This allows you to expand your
handheld memory and perform data backup.

Refer to "Top view" on page 5 for the location of the SD/MMC slot.

Inserting an SD/MMC card

1 Hold your handheld securely.
2 Insert the card into the SD/MMC slot.
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3 Push the card into the slot using your finger until you feel the card lock and hear an
audible system sound. This indicates that the card is properly seated within the slot.

Removing an SD/MMC card

1 Hold your handheld securely.

2 Release the card from the slot by using your thumb to push against the top of the
card, as if you were pushing it further into the slot (a). An audible system sound and a
click will signal that the card has been released.

3 Gently remove the card from the slot (b).

Using an USB thumb drive

Your Acer n30 supports USB host expansion. Via 3-in-one sync cable, you can access a
USB thumb drive directly on your n30.

Inserting an USB thumb drive
1 Get the 3-in-one sync cable, and attach its 26-pin connector to the handheld.
2 Insert the USB thumb drive into USB host port of 3-in-one sync cable.

Removing an USB thumb drive
1 Remove the USB thumb drive from USB host port of 3-in-one sync cable.

2 You can keep 3-in-one sync cable attached to handheld, or remove it from handheld.
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3 Exchanging and updating
data using ActiveSync®.

Using ActiveSync®, you can synchronise information in Microsoft Outlook or Microsoft
Exchange on your computer with your handheld. You can also synchronise this
information directly with a Microsoft Exchange server. Each time you synchronise,
ActiveSync compares the changes you made on your handheld and computer or server
and updates both locations with the latest information. For example:

¢ Keep Pocket Outlook data up-to-date by synchronising your handheld with
the Microsoft Outlook data on your computer.

¢ Synchronise Microsoft Word and Microsoft Excel files between your handheld
and computer. Your files are automatically converted to the correct format.

For information on using ActiveSync, see ActiveSync Help on the your computer.

NOTE: By default, ActiveSync does not automatically synchronise all types of information.
Use ActiveSync options to turn synchronisation on and off for specific information types.

With ActiveSync, you can also:
e Back up and restore your handheld data.
¢ Copy (rather than synchronise) files between your handheld and computer.
e Control when synchronisation occurs by selecting a synchronisation mode.
For example, you can synchronise continually while connected to your
computer or only when you choose the synchronise command.

¢ Select which information types are synchronised and control how much data
is synchronised.
For example, you can choose how many weeks of past appointments you
want synchronised.

i ; ®
Using ActiveSync®.
Before you begin synchronisation, install ActiveSync on your computer from the
Acer n30 Handheld Companion CD.

NOTE: ActiveSync is already installed on your handheld.

For more information on installing ActiveSync, see "Installing the Microsoft®
ActiveSync® software".

To open ActiveSync on your handheld, tap , and then tap ActiveSync.
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For information about using ActiveSync on your computer, start ActiveSync on your
computer, and then see ActiveSync Help.
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change synchronization settings.
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O Getting connected

You can use your handheld to exchange information with other mobile devices as well
as your computer, a network, or the Internet. You have the following connection
options:

e Use the infrared (IR) or Bluetooth on your handheld to send and receive data
from another infrared-enabled or Bluetooth-enabled device.

e Connect to your Internet service provider (ISP). Once connected, you can send
and receive email messages by using Inbox and view Web or WAP pages by
using Microsoft® Pocket Internet Explorer.

The communication software for creating an ISP connection is already
installed on your handheld. Your service provider will provide software
needed to install other services, such as paging and fax services.

e Connect to the network at your company or organisation where you work.
Once connected, you can send and receive email messages by using Inbox,
view Web or WAP pages by using Microsoft® Pocket Internet Explorer, and
synchronise with your computer.

e Connect to your computer to synchronise remotely. Once connected, you can
synchronise information such as your Pocket Outlook information.

NOTE: Bluetooth is available only for n30-B.

Transferring items using infrared or Bluetooth

Using infrared (IR) or Bluetooth , you can send and receive information, such as
contacts and appointments to/from other IR-enabled or Bluetooth-enabled devices.

Your n30 will receive all incoming InfraRed (IR) or Bluetooth beams and asks you after
the transmission has been established whether you wish to accept those beams.

To know wheather Bluetooth is on, check the Bluetooth LED. The falshing Bluetooth
LED indicates Bluetooth is on. The off Bluetooth LED indicates Bluetooth is off. There
are only two modes - flashing or off, for Bluetooth LED.

Refer to "Left view" on page 4 for the location of your handheld’s IR port.

NOTE: Bluetooth is available only for n30-B.

To send information via infrared

Switch to the program where you created the item you want to send and locate the
item in the list.

Align the IR port of your handheld with that of the receiving IR-enabled device so that
they are unobstructed and within a close range.
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Tap and hold the item, and then tap Beam Item on the pop-up menu.
_or_
Send items (but not folders) using File Explorer.

e Tap and hold the item you want to send and then tap Beam File on the
pop-up menu.

To receive information via infrared

Align the IR port of your handheld with that of the sending IR-enabled device so that
they are unobstructed and within a close range.

Have the owner of the sending device transmit the information to you. Your
handheld will automatically receive it.

To send information via Bluetooth

Switch to the program where you created the item you want to send and locate the
item in the list.

Tap-and-hold on the item and from the pop-up menu, tap send via Bluetooth.
On the Select a Bluetooth device screen, tap the name of the destination device, and
then tap OK.

To receive information via Bluetooth

Make sure that Bluetooth is enabled, and File Transfer service is also enabled.

Have the owner of the sending device transmit the information to you. Your
handheld will automatically receive it. Note that if Authorization required or
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Authentication (Passkey) required is checked in the File Transfer service Tab, you will
be prompted to accept or enter passkey before allowing transmission.

Connecting to the Internet

To create a modem connection to an ISP
1 Obtain the following information from your ISP:
e ISP server telephone number
e User name and password
e TCP/IP settings
2 Insert a SD Modem card (purchased seperately) into your handheld’s SD/MMC slot.

NOTE: For instructions on inserting and using a SD Modem card, see the documentation
that came with the card.

3 Tap B and then Settings.
In the Connections tab, tap Connections. Under My ISP, select Add a new modem
connection.

4 Enter a name for the connection, such as "My Connection."

5 In the Select a modem list, select your modem type.
If your modem type does not appear, try re-inserting the modem card.

6 You should not need to change any settings in Advanced. Most ISPs now use a
dynamically-assigned address. If the ISP you are connecting to does not use a
dynamically-assigned address, tap Advanced and then the TCP/IP tab, and enter the
address. When finished, tap OK and then Next.

Enter the ISP phone number, and tap Next.

8 Enter your username, password and domain (if any), and tap Finish to complete the
process.

To connect to your ISP, open the Connections main window and tap Manage Existing
Connections. Tap and hold on the applicable dial-up settings and select Connect. Your
modem will dial-out and attempt to create the connection.

To create a connection to an ISP over Bluetooth

If you have access to a cellular phone with Bluetooth support, you can connect to
online resources using your phone as a modem over a Bluetooth link. To configure
your handheld to do this, select Add a New Modem Connection from the My ISP after
tapping [37] and then Settings then Connections icon in the Connections tab.

NOTE: Bluetooth is available only for n30-B.
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Notice the Bluetooth modem selection available in the Make New Connection wizard.
Choose an appropriate name for the connection so as to distinguish it from standard
modem connections.

You will be asked to select a Bluetooth phone or select New... to find a new phone.
Once a Bluetooth-enabled phone has been found, highlight its name and press Next.

Check your cellular phone's instruction manual to determine screen inputs for the
forthcoming Bluetooth bonding screens. On your n30, you will be asked to enter the
PIN selected on your cellular phone. Both PINs must match or bonding will fail.

Select a name for the Bluetooth bond. Select Finish to exit wizard.

Now you will be presented with a prompt to enter the dialing string to be used in
conjunction with your cellular phone. Consult your cellular phone provider to obtain
this string.

To connect using your new Bluetooth connection, tap the Connections icon in the
notification area and then click the link showing the dialing string you entered for the
Bluetooth connection. Your handheld will attempt to connect to your cellular phone .
Confirm that you are wanting to connect with the cellular phone, and momentarily
you will see the 4.'.'.* icon in the notification tray upon successful connection.

To create a wireless Ethernet connection to an ISP

Insert the wireless Ethernet card into your handheld. For instructions on inserting and
using the Ethernet card, see the documentation that came with the card.

The first time you insert the card, a notification will appear, asking you whether the
installed network card should be used to connect to The Internet or Work. Where
possible, the Service Set Identifier (SSID) will be determined automatically. Select The
Internet, then either accept all default settings by tapping OK (most home networks
will allow you to immediately get online without further configuration) or tap
Settings to configure the connection. Sometimes a network will require a WEP key. If
so, you will be prompted for one at this point.

Select the Advanced tab from the Connections Settings. Select the Network Card tab
to customize how each of your installed network card drivers connects. Highlight the
driver name of the card you wish to configure. Indicate whether My network card
connects to: The Internet. Tap on the name of the driver to receive advanced
options.

Configure the IP address settings in the IP Address tab.
Configure the DNS and WINS settings in the Name Servers tab.
You must remove then reinsert your network card for these settings to take effect.

Select the Network Card button from Connection Settings-Advanced to
configure your wireless networks. Networks that you have already configured are
preferred networks and are listed in the Wireless tab. You can select to connect to
only preferred networks or have your handheld search for and connect to any
available network whether it is preferred or not. Press Add New Settings... if you do
not see a network you'd like to connect to.
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7 In the General tab you can set the network name (also known as SSID); this is only
editable if you are creating a new wireless network profile else you are viewing a
preferred network and the SSID has already been established. Indicate whether this
network will connect you to The Internet. Finally, if this is a new network profile,
you can indicate whether this is a computer-to-computer network.

NOTE: To determine if authentication is needed, check your network administrator.

8 To view your wireless network connection after the preceding steps have been

followed, press the 1.'.'."' icon in the notification area. A green status indicator will
show how strong your signal is. Tapping Turn Wireless Off will turn off your network

card radio. Pressing the ':x icon will then allow you to Turn Wireless on.

Once your network card has been configured, you will immediately be connected.

Connecting to a network

If you have access to a network at work, you can send email messages, view Intranet
pages, synchronise your handheld, and access the Internet. You can connect to a
network in one of three ways:
e Create a modem connection by using an RAS account.
¢ Use an wireless Ethernet card and a net tap to connect to the network.
If this is the method you want to use, see "To create an wireless Ethernet
connection to a network" on page 69.
Your n30 handheld supports a SD wireless Ethernet card or a SD Modem card.

¢ Create a Bluetooth connection to a cellular phone as a modem with
Bluetooth support.

NOTE: Bluetooth is available only for n30-B.

To create a modem connection to a network

Follow the instructions stated in "To create a modem connection to an ISP" section,
but select Add a new modem connection under My Work Network to begin.

To create a wireless Ethernet connection to a network

Follow the instructions stated in "To create a wireless Ethernet connection to an ISP"
section, but connect to Work under notification bubble to begin.

To create a connection to a network over Bluetooth

Follow the instructions stated in "To create a conection to an ISP over Blouetooth”
section, but Add a new modem connection from work under connection tab.
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NOTE: Bluetooth is available only for n30-B.

End a connection

To disconnect, do one of the following:

When connected via Infrared, move your handheld away from the computer.

When connected via a wireless (Ethernet) card, remove the card from your
handheld.

When connected via Bluetooth, turn off Bluetooth to terminate connection.

NOTE: Bluetooth is available only for n30-B.

Get help on connecting

More information on the procedures described here, as well as information on
additional procedures, can be found in the following locations:

The section on "Inbox" on page 38.

Online Help of your handheld. Tap [&f] and then Help. Tap View, All Installed
Help, and then Inbox or Connections.

ActiveSync Help on the your computer. In ActiveSync, click Microsoft
ActiveSync Help on the Help menu.

For troubleshooting information, see the Pocket PC Web site at
(http://www.microsoft.com/mobile/pocketpd/).
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10 Using Microsofte
Pocket Internet Explorer

Use Microsoft® Pocket Internet Explorer to view Web or WAP pages in either of these
ways:
¢ During synchronisation with your computer, download your favorite links

and mobile favorites that are stored in the Mobile Favorites subfolder of
Internet Explorer on your computer.

¢ Connect to an Internet service provider (ISP) or network and browse the Web.
To do this, you'll need to create the connection first, as described in "9
Getting connected" on page 65.
When connected to an ISP or network, you can also download files and programs
from the Internet or intranet.

Mobile Favorites folder

Only items stored in the Mobile Favorites subfolder in the Favorites folder of Internet
Explorer on your computer will be synchronised with your handheld. This folder was
created automatically when you installed ActiveSync.

Favorite links

During synchronisation, the list of favorite links in the Mobile Favorites folder on your
computer is synchronised with Pocket Internet Explorer on your handheld. Both
locations are updated with changes made to either list each time you synchronise.
Unless you mark the favorite link as a mobile favorite, only the link will be
downloaded to your handheld, and you will need to connect to your ISP or network to
view the content.

For more information on synchronisation, see ActiveSync Help on your computer.

Mobile favorites

If you are using Microsoft Internet Explorer 5.0 or later on your computer, you can
download mobile favorites to your handheld. Synchronising mobile favorites
downloads Web content to your handheld enable you to view pages while you are
disconnected from your ISP and computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites
quickly.
To create a mobile favorite

1 In Internet Explorer on your computer, click Tools and then Create Mobile Favorite.
2 To change the link name, enter a new name in the Name box.
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Optionally, in Update, select a desired update schedule.

NOTE: If you did not specify an update schedule, you will need to manually download
content to keep the information updated on both your computer and handheld. Before
synchronising with your handheld, in Internet Explorer on your computer, click Tools and
then Synchronise. You will see the last time content was downloaded to the computer, and
you can manually download content if needed.

Click OK.
Internet Explorer downloads the latest version of the page to your computer.

TIP: You can add a button to the Internet Explorer toolbar for creating mobile favorites. In
Internet Explorer on your computer, click View, Toolbars, and then Customise.

To download a mobile favorite

Right-click the mobile favorite and then click Properties.

In the Download tab, specify the number of links deep you want to download.
To conserve handheld memory, go only one level deep.

Synchronise your handheld and computer.

Mobile favorites that are stored in the Mobile Favorites folder in Internet Explorer are

downloaded to your handheld.

To save handheld memory

Mobile favorites take up storage memory on your handheld. To minimise the amount

of memory used, observe the following:

¢ In the settings for the Favorites information type in ActiveSync options, turn
off pictures and sounds, or stop some mobile favorites from being
downloaded to your handheld.

¢ Limit the number of downloaded linked pages.

a Inlinternet Explorer on the computer, right-click the mobile favorite you want

to change and then click Properties.

b  Inthe Download tab, specify 0 or 1 for the number of linked pages you want

to download.

Using Pocket Internet Explorer

You can use Pocket Internet Explorer to browse mobile favorites and channels that

have been downloaded to your handheld without connecting to the Internet. You can

also connect to the Internet through an ISP or a network connection and browse the
Web.

To view mobile favorites and channels
Tap the Favorites button to display your list of favorites.
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Tap the page you want to view.

You'll see the page that was downloaded the last time you synchronised with your
computer. If the page is not on your handheld, the favorite will be dimmed. You will
need to synchronise with your computer again to download the page to your
handheld, or connect to the Internet to view the page.

To browse the Internet

Set up a connection to your ISP or corporate network, as described in"9 Getting
connected” on page 65.

To connect and start browsing, do one of the following:

¢ Tap the Favorites button, and then tap the favorite you want to view.

e Tap View and then Address Bar. In the address bar that appears at the top of
the screen, enter the Web address you want to visit and then tap Go. Tap the
arrow to choose from previously entered addresses.

e To add a favorite link while using the handheld:
a Goto the page you want to add.

b  Tap and hold on the page.
¢ Tap Add to Favorites.
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11 Customising your
handheld

You can customise your handheld based on your personal requirements and
preferences as well as depending on your usual work modes. Customise your
handheld by doing either of the following:

e Adjust the handheld settings

e Add or remove programs

Adjusting handheld settings

You can adjust the settings of your handheld to suit the way you work.

To access Settings

o Tap [, then Settings.
Tap an available Settings option to open the corresponding adjustment page.

The Settings window has three tabs—Personal, System, and Connections, each of
which has its own set of options.

The succeeding sections shows the configuration page of each the Settings options.
For detailed instructions on these pages, access the page then tap [F] then, Help.

Adding and removing programs

Programs bundled with your handheld at the factory are stored in ROM (read-only
memory). You cannot remove these programs, and you'll never accidentally lose ROM
contents. ROM programs can be updated using special installation programs. All other
programs and data files installed to your handheld after factory installation can be
stored in RAM(random access memory) or ROM storage(a file folder in your handheld
which in fact is a ROM space specially reserved for user access). The ROM storage can
be accessed through File Explorer, too.

You can install any program created for your handheld, as long as it has enough
memory. The most popular place to find software for your handheld is on the Pocket
PC Web site (http://www.microsoft.com/mobile/pocketpd/).

Adding programs

You could add programs to your handheld either by using ActiveSync or by
downloading the program from the Internet.
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To add programs using ActiveSync

You'll need to install the appropriate software for your handheld on your computer
before installing it on your handheld.

Determine your handheld and processor type so that you know which version of the
software to install.

a Tap and then Settings.
b  On the System tab, tap About.
¢ Inthe Version tab, make a note of the information in Processor.

Download the program to your computer (or insert the CD or disk that contains the
program into your computer).

You may see a single *.xip, *.exe, *.cab, or *.zip file, a Setup.exe file, or several
versions of files for different device types and processors. Be sure to select the
program designed for a Pocket PC and your handheld’s processor type.

NOTE: Read any installation instructions, Read Me files, or documentation that comes with
the program. Many programs provide special installation instructions.

Connect your handheld to your computer.
Double-click the *.exe file.

e If the file is an installer, the installation wizard will begin. Follow the
directions on the screen. Once the software has been installed on your
computer, the installer will automatically transfer the software to your
handheld.

e If the file is not an installer, you will see an error message stating that the
program is valid but it is designed for a different type of computer. You will
need to move this file to your handheld. If you cannot find any installation
instructions for the program in the Read Me file or documentation, use
ActiveSync Explore to copy the program file to the Program Files folder on
your handheld. For more information on copying files using ActiveSync, see
ActiveSync Help.

Once installation is complete, tap irf Programs, and then the program icon to

launch it.

To add a program directly from the Internet

Determine your handheld and processor type so that you know which version of the
software to install.

a Tap and then Settings.
b  On the System tab, tap About.
¢ Inthe Version tab, make a note of the information in Processor.

Download the program to your handheld straight from the Internet using Pocket
Internet Explorer.

You may see a single *.xip, *.exe, *.cab, or *.zip file, a Setup.exe file, or several
versions of files for different device types and processors. Be sure to select the
program designed for a Pocket PC and your handheld’s processor type.
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NOTE: Read any installation instructions, Read Me files, or documentation that comes with
the program. Many programs provide special installation instructions.

Tap the file, such as a *.xip or *.exe file.
The installation wizard will begin.

Follow the directions on the screen.

To add a program to the Start menu

e Tap [a], Settings, Menus, the Start Menu tab, and then the check box for the
program.
If you do not see the program listed, you can either use File Explorer on your
handheld to move the program to the Start Menu folder, or use ActiveSync
on your computer to create a shortcut to the program and place the shortcut
in the Start Menu folder.

— Using File Explorer on your handheld

a Tap Ej Programs, File Explorer, and locate the program (tap the folder
list, labeled My Documents by default, and then My Device to see a list of
all folders on your handheld).

b Tap and hold the program and tap Cut on the pop-up menu.

¢ Open the Start Menu folder located in the Windows folder, tap and hold
a blank area of the window.

d Tap Paste on the pop-up menu.
The program will now appear on the menu.

For more information on using File Explorer, see "To use File Explorer" on page
28.

— Using ActiveSync on your computer
a Use the Explorer in ActiveSync to explore your handheld files and locate
the program.

b  Right-click the program, and then click Create Shortcut.
¢ Move the shortcut to the Start Menu folder in the Windows folder.
The shortcut now appears on the Start Menu.
For more information on using ActiveSync, see ActiveSync Help on your computer.

Removing programs

[3%] and then Settings.
On the System tab, tap Remove Programs.

Tap

Tap the program you wish to remove, then tap the Remove button.

If the program does not appear in the list of installed programs, use File Explorer on
your handheld to locate the program:

Tap and hold the program.
Tap Delete on the pop-up menu.
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Bluetooth Utility

Appendix: Exchanging
and updating data using
BluetOOth Ut|||ty (only for n30-B)

This chapter provides overview description for using services provided by Bluetooth
Utility which includes Bluetooth Setting and Bluetooth Manager.

Bluetooth Utility

Bluetooth utility is the solution for the seamless integration of Bluetooth technology
into devices that use the PocketPC operating system. It provides handheld with the
means to:

Locate other Bluetooth devices in the immediate vicinity (inquiry)
Discover the services that those devices offer (discovery)
Connect to, use, and disconnect from those services
Enable/disable individual services
Security features, on a service-by-service basis, including:

— Authentication

— Authorization

— Encryption

Bluetooth Icon

The Bluetooth icon in the lower-right corner of the Today screen provides quick access
to the Bluetooth Manager and Bluetooth Settings.

It also provides visual feedback about the state of Bluetooth:

When Bluetooth utility is active (on) the Bluetooth icon is blue .
If Bluetooth utility is disabled (off) the icon appears grayed with a red circle

around a white X -€3- in the lower-right corner&.

While the Bluetooth software loads (one to five seconds, depending on your
system), the icon is blue in the upper-left diagonal, gray in the lower-right

diagonal, and the red circle is in place%.

Apply Power To The Bluetooth Hardware
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The first screen Bluetooth Settings has ON/OFF buttons to apply/remove power to the
hardware.

Bluetooth Settings

The Bluetooth Settings screen's tabs are :

e Gerneral
— User profile selection
— Bluetooth status (ON/OFF) indicator
— Hardware power control (ON/OFF)
— Shortcut to the Bluetooth Manager
e Accessibility
— Set the device name
— The handheld's Bluetooth Device Address (BDA)
— Determine which remote devices are allowed to connect
— Determine whether remote devices can "see" this handheld
¢ Service tabs-Bluetooth can provide four services. They are:

- File Transfer-set the highest-level directory on this handheld that remote
devices will be able to access.

- Information Exchange-Set the default business card (Pocket Outlook
contact entry)

— Serial Port-Bluetooth serial port information
— Dial-up Networking-configure the COM port, baud rate and flow control.
— Personal Network Server-configure the service availability
¢ About-there are no configurable options on this tab.
— Software version information
— Copyright information
— Website and Technical Support links.

Bluetooth Manager

The Bluetooth Manager allows you to create, manage, and use Bluetooth connections
with remote devices.

To access Bluetooth Manager:

e From the Today screen, tap F# and then:
— tap > Programs > Bluetooth Manager.
or

¢ Inthe lower-right corner of the screen, tap the Bluetooth icon and then select
Bluetooth Manager.

Bluetooth Manager has :
e Two tabs:
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Bluetooth Browser

— My Shortcuts-displays a list of pre-configured connections and establishes
connections

— Active Connections-displays active incoming and outgoing connections.
e Three menus:
- New
Connect!-create a new connection
- Tools
Paired devices-pair/un-pair with other devices

Business Card Exchange-opens the Business Card Exchange.

— View-controls the on-screen display (icons or list).

Bluetooth Browser

Various Bluetooth applications require you to select the device you want to connect
to.

The Bluetooth Browser appears and searches for other Bluetooth devices. As the
search progresses, the found devices are listed in the window. To select a device from
the list, tap it. You do not have to wait for the search to finish; as soon as the desired
device appears in the list, tap it to select it and return to the previous screen.

Remote Device Services

This section provides overview instructions for using services provided by other
devices.

Series Port

The use of a Bluetooth wireless serial port connection is identical to the use of a
physical cable serial port connection between two devices.

As with a physical connection, the application that will use the connection must be
configured to use the correct serial port.

To determine the communications port assigned to the Bluetooth serial port:
¢ In the lower-right corner of the Today Screen, tap the Bluetooth icon, and
then select Bluetooth Settings.

e Use the scroll arrows at the bottom-right of the screen to expose the Serial
Port tab, and then select the Serial Port tab.

The Outbound COM Port is listed in the lower portion of the screen.

Configure the application that will use the Bluetooth Serial Port to send data
to this port.

¢ From Bluetooth Manager's My Shortcuts screen open the Bluetooth serial
port connection to the remote device.

¢ Send/Receive data from the application.
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Dial-up Networking: Connect To A Remote Computer

Dial-up Networking allows you to connect to a remote computer via a phone line.
Once connected, you can browse the Internet, check your email, etc.

The remote Bluetooth device that will provide the Dial-up Networking service must
have access to a telephone system (either a hard-wired or cellular connection).

Devices that might provide the Dial-up Networking service include:

¢ Bluetooth-enabled cellular telephones

¢ Bluetooth-enabled desktop computers that are attached to a telephone
system

e Bluetooth modems.

The remote computer to which you are connecting must also be attached to the
phone system and capable of answering a call.

Bluetooth File Explorer

Bluetooth File Explorer appears automatically when a File Transfer connection is
established. It allows you to:

¢ Navigate the directory structure of the remote device

¢ View files and folders on the remote device

e Create new folders on the remote device

¢ Send files to, and get files from the remote device

¢ Delete files on the remote device.

NOTE: File operations on the remote device are limited to the remote device's configured
FTP root directory and its sub-directories.

Bluetooth File Explorer also allows you to set the folder on your handheld that will
receive inbound files. This folder is configurable on an individual basis for each
connection shortcut.

Send Via Bluetooth
Pocket Outlook contacts, calendar items, and tasks can be sent individually or
collectively to a remote device.
To send data via Bluetooth transfer:
e From the Start menu, Programs, open Calendar, Contacts or Tasks
¢ Highlight the item(s) to be sent

¢ Tap-and-hold the item(s), and from the pop-up menu, tap Send via
Bluetooth.

e On the Select a Bluetooth device screen, tap the name of the destination
device, and then tap OK.

Dial Via Bluetooth

Dial via Bluetooth lets you select a contact from the Pocket Outlook Contact list and
have your paired cell phone dial the contact's phone number. If a contact has more
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Remote Device Services

than one phone number, you can select the number to be dialed. Phone numbers can
also be modified before they are dialed.

To use the Dial via Bluetooth feature :
e From Pocket Outlook's Contact screen, tap-and-hold a contact and select Dial
via Bluetooth.

¢ If this handheld is paired with more than one cell phone, or if a phone is not
already selected, tap the phone icon next to "Select a phone:" and choose
the phone to be used.

¢ Select the number to be dialed and tap "Dial Number."

¢ To modify the number to be dialed, tap "Edit Number," make the changes to
the number, tap OK to return to the previous screen, and then tap "Dial
Number."
After the number is sent to the cell phone, the handheld closes the connection. If the
phone number was modified, a dialog box appears with the option to save or discard
the modification.

After the cell phone completes the dialing process, the phone can be used in the
normal way.

Bluetooth Personal Area Network

A Bluetooth personal area network is a private, temporary, ad-hoc network of up to
eight devices. A Bluetooth personal area network makes it easy to exchange
information that would normally require a TCP/IP network. For example, most chat
utilities, multi-player games, etc. are fully functional in a Bluetooth personal area
network environment.

Bluetooth private area networks are subject to the same security settings that govern
other Bluetooth communications (service availability, authorization, authentication
and encryption).

One Bluetooth device must be the host of the personal area network. Other Bluetooth
devices join the network as clients.

The host can accept and reject clients on an individual basis.
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